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The purpose of this manual is to provide a basic understanding of the Apex Instruments 
automated sampling console available for Appendix K Mercury Sampling. The MercSampler 
Model XC-6000EPC console is applicable for Mercury Emissions Sampling Using Iodinated 
Charcoal Traps.  For additional information on the applicable Appendix K method, please visit 
http://www.epa.gov/air/mercuryrule/. 

�
������ 	������������������	�����
The MercSampler Console is the operator’s control station that controls and captures data necessary 
for paired sorbent tube sampling according to Appendix K. The basic principle of the console is to 
control the sample flow rate proportionally to the stack gas flow rate and determine the standardized 
volume extracted through each sorbent trap. To capture the samples, a pair of diaphragm vacuum 
pumps work in concert with proportional valves and mass flow sensors. Optical encoders are mounted 
inside the gas meters to provide digital feedback for the volume sampled. From additional temperature 
and pressure measurements the sample volume at standard conditions (USEPA 20°C and 760mmHg) 
is calculated. Figure 1-1 illustrates the Apex Instruments Model XC-6000EPC. 
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Depending on the application and stack configuration, three versions of the XC-6000EPC 
MercSampler are available.   

8U rackmount – robust, portable enclosure with a separate Stirling Cooler. 

Portable weathertight case – Highly portable MercSampler housed in ABS molded case (wheeled 
enclosure with telescoping handle) for use with a separate Stirling Cooler. 

Environmental enclosure – permanent, weathertight enclosure with room for a rackmount Stirling 
Cooler. 
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Features XC-6000EPC MercSampler Console 

Gas Meter Positive displacement diaphragm meter, 45 Lpm 
maximum and 0.17 Lpm starting flow rate, 
0.7L/revolution 

Meter Display Direct-read index or electronic totalizer with 
9999.9999 cubic meter capacity, 0.2 Liter resolution 
(direct read) or 0.001 Liter (totalizer.)  Optical 
encoder with quadrature pulse output to CPU 
increases volumetric resolution to 1 cubic 
centimeter or 0.001 Liters.   

Sample Pump Internal Hargraves miniature diaphragm pump.  
Brushless DC (BLDC) Motor rated at 12VDC.  
>20inHg Maximum Vacuum.  ~4Lpm maximum 
unrestricted flow. 

Proportional Valve Pneutronics Voltage Sensitive Orifice (VSO) Series. 
47ohm, 12VDC 

Mass Flow Sensor Honeywell AWM Series. 100-4000ccm. 

Barometric Sensor AllSensors 600-1000mBar, 5VDC Supply 

Vacuum Sensor Vaccon 0-30”Hg 

Flow Meter Dwyer 100 – 2500 ccm 

Umbilical 
Connections 

Electrical: 4-pin locking Amphenol connectors 

Sample Line: ¼” Stainless Steel Quick-Connect or 
Swagelok fittings 

Dimensions 17 in x 14 in x 17 in (W x H x D) 

Power Requirements 120VAC/60Hz standard 2 or more 15A circuits 
depending upon configuration (230VAC/50Hz 
optional) 

 

Weight 35 lbs (16 kg) not including enclosure 
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The MercSampler Console is comprised of plumbing and electrical (including thermocouple and 
electronic circuits) subsystems that work together to give appropriate control and feedback. 

 

Plumbing Subsystem 

Dry Gas Meter

Flowmeter
200-1000ccm

Vacuum Pump
S P

Internal Delta P
Transducer
±5" H2O

3-Way Valves
(Auto Zero
Transducers)

Hi Lo

Vacuum
Sensor

Barometric / Total Stack
PressureTransducer
600-1100 mBar

2-Way Valve

Proportional
Valve

Mass Flow
SensorInline 

Filter

Suction Pressure

Two Complete
Independent Systems

Optional Internal Delta P System

DGM TC

Sample Inlet 
1/4" QC
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Electrical Subsystem 
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Console Connection Diagrams 

 

!�"����#$8�%����������������"�� �5���&�$'(((������� ������.�������������

 

!�"����#$8.%����������������"�� �5���&�$'(((������� ���� ������9���/���� ����������������

�



�
�
� � � 
 � � � � � � � � � � � � � � � 
 � � � � � � � � � � � � �
�

Apex Instruments, Inc. | Phone: 919.557.7300 | Fax: 919.557.7110 | Web: www.apexinst.com  | e-mail: info@apexinst.com 
�

9 

�
�

 

·  The Source Sampler Console is factory-configured for 115 VAC / 60 Hz electrical power.  
Configuration for 220 VAC / 50 Hz operation is an available option. 

·  The AC electrical subsystem provides switch power to each circuit, controlled by two 
switches:  MAIN and PROBE. 

·  All circuits are protected by a MAIN 15 Amp (10 Amp 220V) circuit breaker.  Additionally, 
the probe is protected by a 10 Amp breaker. These circuit breakers detect and interrupt 
overload and short circuit conditions, providing an important safety factor.  If the circuit 
breaker opens, or “trips,” indicating interruption of the circuit, investigate and repair the 
electrical fault, and then reset the breaker by pressing the circuit breaker switch. The Electrical 
Schematic for the Source Sampler Console is presented in Figure 1-3. 

·  Two custom-designed and manufactured circuit boards, a Data Acquisition and Control 
(DAC) board and Thermocouple (TC-MUX) board, are utilized. 
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The MercSampler includes firmware preloaded on its DAC and TC/MUX boards. Also included is 
Windows-based interface software. Apex Instruments recommends the purchase of a laptop or 
desktop computer directly through Apex to ensure computer compatibility and proper loading of 
software. However, if you prefer to use or purchase your own computer please ensure your computer 
has, as a minimum, the following specifications. 

Item Description Capacity 

CPU Processor Speed 1GHz+ 

RAM Random Access Memory >512MB 

HDD Hard Drive Capacity ~12MB for Software. Data file storage varies. 

O/S Operating System Windows XP SP2 or Vista 

Loading Software 

To load MercSampler software on your laptop or desktop computer, follow these steps: 

Insert the Apex XC-6000 MercSampler CD-ROM into your computer CD-ROM drive.  Open the 
drive letter of the CD-ROM drive (sometimes D:\ or E:\) and copy the “Apex” folder to the root 
directory of your system drive (C:\.)  

If installing from an electronically distributed copy (email, web, etc.) please unzip the xc6000.zip file 
to C:\Apex. 

The software must be installed in the C:\Apex directory on your computer.  Please delete any files 
currently in the C:\Apex directory, then copy the files from the CD-ROM or .zip file to the C:\ drive. 

The software is now installed correctly.   

Driver Installation 

The Apex XC-6000EPC includes a USB connection functionality, which is implemented using a 
virtual serial port on the connected PC.  To install drivers for this serial port, please perform the 
following steps: 

Power down the XC-6000EPC MercSampler if it is not already powered off by switching the main 
Power switch to the “off” position. 

Connect the XC-6000EPC to the PC using the included USB cable.  For XC-6000EPC units with two 
USB connectors on the rear panel, please connect to the port nearest the edge of the unit (left port 
when facing the rear panel.) 
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Windows will discover the XC-6000EPC.  The Windows “Found New Hardware Wizard” will 
appear onscreen. 

 

Please select “Install from a list or specific location (Advanced.) 

 

Use the “Browse” button to find the folder where the XC6000 application is installed (usually C:\ 
Apex) and then navigate to the “FT232_UART_Driver” subfolder. (C:\ Apex\FT232_UART_Driver)  
Click “Next.” 
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The drivers for the serial converter (UART) will be installed.  Press “Finish.” 

 

Windows will then discover the virtual serial port.  The installation for the serial port drivers is the 
same as for the serial converter.  The “Found New Hardware Wizard” will start: 

 

Select “Install from a list or specific location (Advanced,)” and press “Next.” 
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Select the driver location (same as for the serial converter installed previously) and press “Next.” 

 

The wizard will complete.  Press “Finish.” 

Open the System Properties control panel (either open Control Panel > System or right click on My 
Computer and select “Properties.” 
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Click the “Hardware” tab, then click “Device Manager.” 

 

When the Device Manager opens, open up the “Ports (COM & LPT)” item and make sure that a 
“USB Serial Port” is installed.  Please make a note of the COM number (in this case, it is COM4, but 
your installation may vary.)
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Upgrading Firmware 

From time to time, Apex Instruments may release updated device firmware for the XC6000EPC 
console.  These firmware upgrades may add additional functionality or capabilities to the console, and 
may be required in order to use the latest version of the monitor / control client software.  If the 
XC6000 software displays a message regarding your firmware revision number, please contact Apex 
Instruments to get more information. 

The XC6000EPC firmware may be programmed using a PC and the Apex Firmware Programming 
Cable.  PLEASE NOTE:  The drivers for the programming cable and the version of the XC6000 
firmware most current at the time of shipment are installed along with the Apex software.  Please 
install the Apex XC6000EPC software before attempting to upgrade the firmware. 

The Apex Firmware Programming Cable uses a USB Serial Converter similar to the one in the main 
console.  When connecting the Firmware Programming Cable to the PC for the first time, the Found 
New Hardware Wizard may appear.   

Early revision program cables have a 6-pin Molex connector on one end, and a 9-pin D-sub connector 
on the other.  These cables are supplied with a USB serial adaptor (usually made by Belkin.) Please 
follow the same directions as detailed above in Software Installation, directing the wizard to the “C: 
\Apex\F5U109 USB Serial Port Driver” folder.  Once the drivers are installed, please re-open the 
Device Manager and note the COM number of the new serial port installed by the Apex Firmware 
Programming Cable. 

    

�:$;�����������"����� � � ��:$�����"�

For later revision programming cables with the 6-pin Molex connector and a 4-pin USB A connector 
on the other, please use the same steps as for connecting the XC6000 to the PC via USB.  The later 
programming cables use the same USB converter as the XC6000 so no additional drivers are 
necessary.  The COM port installed may not be the same as the XC6000 virtual COM port, so please 
re-open the Device Manager and note the COM number of the new serial port installed by the Apex 
Firmware Programming Cable. 
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Version # 

Important Notes About Upgrading Firmware: 

The older versions of the XC6000 firmware lack several important new features of the current 
consoles.  These include the ability to set alarms based on test conditions, the optional ability to 
sample at flow rates above 1Lpm, and the provision for communication with the optional 
ModBus module.  In addition, the calibration tables for the older versions may not be 
immediately compatible with the newer versions, and some conversion must be performed. 
Before upgrading your XC6000 firmware, please connect the console to your current software 
and make a note of the application and firmware version. 
 
 

 
 
The application version is visible before the console is connected.  Once the console makes 
connection, the firmware revision is displayed to the right of the application version number, 
separated by a dash:  “081031-99.”  Make a note of these version numbers. 
 
Once connected, enter the Config / Utilities screen and then the Calibration screen.  Enter the 
word “enable” (no quotes) into the protected password space on the Calibration screen.  Press the 
“Save to File” button.  Choose a location for your saved table, and give it a unique name. 
 
IMPORTANT NOTE:  Always save the XC6000 calibration table to a file before upgrading the 
console firmware.   
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Programming the XC6000 Firmware 

 
1. Ensure XC6000EPC console is powered off.  Disconnect any connecting cables from the 

console, and remove the console from its rack enclosure.  Remove the nine (9) screws from 
the top of the unit and the six (6) screws from the outside left and right edges of the rear panel, 
and open the lid of the console by lifting it up from the front.  Please note:  portable case units 
must unlatch the front panel retaining screws and fold down the front panel to access the DAC 
board. 

2. Units installed in an environmental enclosure may have a separate firmware programming 
connector located on the front panel of the unit.  For units in an environmental enclosure, 
please connect the programming cable to the front-panel connector, and proceed to Step 4. 

3. Upgrading the XC6000EPC console from version 070904x-46 or similar to a higher firmware 
revision (above 46) will require the DSP processor to be programmed as well as the Main 
processor.   If your console does not require a DSP firmware upgrade, please skip to step 15. 

 
Programming the DSP Processor – SKIP THIS STEP UNLESS UPGRADING FROM v46 
or lower! 
 
4. Remove the 20-pin ribbon cable from the XC6000EPC TC/MUX board. 

Reference:  Figure DAC-1 below, item A. 
5. Connect the 6-pin Molex connector on the end of the programming cable to the DAC board 

header labeled DSP Firm Pgm 
Reference:  Figure DAC-1 below, item B. 
 

Password 

Calibration 
Screen 2 

Save To File 
Restore from File 

DGM Gamma 
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6. Power on XC6000EPC console 
7. Navigate to the install location 

default: C:\Apex\Firmware 
8. Execute dl.exe 
9. The Tiny Bootloader window will launch 
 

 
��%�&��$������:����������

 
10. Click Browse and select ApexDSP.hex from the current directory  
11. Select the following options: 

·  Comm: 115200 
·  Comm (use the COM number noted earlier) 
·  Enable Options -> Reset PIC using RTS line 

12. Click Write Flash 
13. When update is complete, Log window will read Write OK.   The writing process should take 

between 3 and 6 seconds. 
14. Power off XC6000EPC console and remove 6-pin Molex connector on the end of the 

programming cable from the DAC board. 
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Programming the Main Processor  
 
15. Connect the 6-pin Molex connector on the end of the programming cable to DAC board 

header labeled Main Firm Pgm 
Reference:  Figure DAC-1 below, item C. 

 

 
 
 
16. Power on XC6000EPC console 
17. Navigate to the install location 

default: C:\Apex\Firmware 
18. Execute dl.exe 
19. The Tiny Bootloader window will launch 
 

 
��%�&��$������:����������

 
20. Click Browse and select ApexMAIN.hex from the current directory  
21. Select the following options: (same as for DSP Processor) 

·  Comm: 115200 
·  Comm (use the COM number noted earlier) 
·  Enable Options -> Reset PIC using RTS line 

22. Click Write Flash 
23. When update is complete, Log window will read Write OK.   The writing process should take 

between 18 and 25 seconds. 



�
�
� � � 
 � � � � � � � � � � � � � � � 
 � � � � � � � � � � � � �
�

Apex Instruments, Inc. | Phone: 919.557.7300 | Fax: 919.557.7110 | Web: www.apexinst.com  | e-mail: info@apexinst.com 
�

20 

�
�

24. Power off XC6000EPC console and remove 6-pin Molex connector on the end of the 
programming cable from the DAC board. 

25. Replace the 20-pin ribbon cable from the TC/MUX board (item A above) 
26. Power on the XC6000EPC console and connect using the XC6000EPC MercSampler 

application.  The version number of the console should appear in the upper right of the 
application window once connected.  Ensure that the version number that the console reports 
matches the version number of the supplied firmware update. 

 

 

 

After a successful upgrade:  

Once the console has been upgraded, the calibration table will need to be converted to the new format.  
Connect to the console and enter the Config / Utilities screen.  Press the “Set Clock” button to ensure 
that the XC6000 has the correct time and date set.  Close the Config / Utilities screen and observe the 
date and time on the Main screen to make sure the time and date are correct and that the time is 
advancing.  Then re-enter the Config / Utilities screen and go to the Calibration screen. 

On the Calibration screen, enter “enable” (no quotes) into the protected password screen.  
Immediately proceed to Calibration Screen 2. 

 

����.��������������-�

Press the “Load” button on the Heaters Proportional Adj. box.  Load the heater table provided to you 
in the update location (the filename will have a .cal_heaters extension.)  Press “Accept” and then 
“Return” to go back to the first page of the calibration screen. 

Load Button 
 
Save Button 

Accept Button 
 
Return Button 
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On the first page, press the “Restore From” button and load the previously saved calibration table.  
The application will fill in mass flow calibration values greater than 1 liter per minute.  Please keep in 
mind that the flow rate may not be accurate above 1 liter per minute unless a calibration is performed 
on the console.  However, if the console is used for lower flow rates (such as the typical flow rates 
used in Appendix K sampling) then the previous calibration values will be correct for these flow rates. 

Once the calibration table is loaded, enter “Gamma” (no quotes, capital G) into the password field.  
On the lower left of the calibration screen, enter the dry gas meter gamma (“Y”) from the dry gas 
meter calibration sheet.  The XC6000 will correct for the meter error automatically. 

Enter “enable” (no quotes) in the password field and press the “Save” button.  Once the table is saved, 
press “Save to File” and save a copy of the new table with a new filename.  Press the Exit / Reset 
button to reset the console and apply the new calibration factors. 

Older test profiles may cause errors when used with newer firmware.  To avoid this, create new 
profiles for performing sample runs.  If an older profile must be used, please step through the profile 
one screen at a time (press the “Next” button) and save the profile with a new filename.  The profile 
should be automatically converted to the newest version. 

 

In addition, connecting a console with older firmware to a PC with a newer version of the XC6000 
application may cause errors.  For best results, please ensure that console firmware and interface 
application versions match. 
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Software Operation 

To start the MercSampler software on your laptop or desktop computer follow these steps: Double 
click the “XC-6000” icon on your desktop. The following screen should appear.  Please take a 
moment to note the version number of the software, which is printed on-screen in the center-right of 
the menu, near the top of the smokestack. 

 
!�"����#$'%�����������������������

If you have already setup the communication method single click the “Connect” button and skip the 
following section and go to the Test Profile section, otherwise follow the instructions that follow to 
setup the communication between the console and the computer. 

Version # 
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Software Communication 

The MercSampler software communicates via USB or Ethernet (optionally wireless Ethernet). To 
connect single click the “Config/Utilities” button. 
The following screen should appear. 
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To connect via USB follow these steps: 
1. Select the “COM Port” button under the Connection Method. 
2. Single click the “Locate COM Ports”. 
3. Select an available COM Port – make sure that this COM number is the same as the COM 

number for the USB Serial Port installed previously. 
4. Single Click “Return” and the Main Screen will appear. 
5. “End” the program and reopen the program by double-clicking the desktop icon. 
6. Single click the “Connect” button. The screen should indicate the console ID, communication 

method and console date/time. 

To connect via Ethernet follow these steps: 
1. Select “TCP/IP” button under the Connection Method. 
2. Type in the IP address 192.168.1.2 and Port 81. 
3. Single Click “Return” and the Main Screen will appear. 
4. “End” the program and reopen the program by double-clicking the desktop icon. 
5. Single click the “Connect” button. The screen should indicate the console ID, communication 

method and console date/time. 
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Important note:   If you experience errors in TCP/IP connection, please follow the steps below: 
 

1. Click the Windows Start button (located in the lower left corner of the screen.) 
2.  Click the Run… button 

 

 
 
3. Type “notepad c:\windows\system32\drivers\etc\hosts” into the Run… window. 
 

 
 
4. The Notepad text editor window should appear, with the Windows HOSTS file loaded.   
5. This file enables the user to specify a DNS entry for a static IP address, which is needed for 

some system configurations. 
 

 
 
6.  Add the text highlighted above:  192.168.1.2          xc6000 
7.  Save the HOSTS file by selecting File -> Save from Notepad’s top menu. 
8.  If you require additional assistance in configuring your TCP/IP settings, including configuring 
the XC6000EPC console to join a plant-wide network, please contact Apex Instruments for 
further technical support.   

PLEASE NOTE: 
The rear-panel Ethernet connection is designated for use with a plant-wide network.  Local 
connections should be made using the front-panel Ethernet connector only.  For rear-panel 
Ethernet configuration, please consult the Apex XC-6000 Advanced Network Configuration 
Guide. 
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 When connected the main screen identifies the console and the communication method as shown 
below: 
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The following summarizes the steps involved in configuring and running a complete test with the 
MercSampler console. 
 

Figure 1-9.  Software Flow Summary  
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��������5�����
The Test Profile is how we configure the console for running a test. A profile can be loaded from the 
internal flash memory on the DAC board inside the console. This is done by single clicking the “From 
Memory” button on the Main screen 
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Once loaded this filename is visible in the lower left corner of the Main screen. This can be edited by 
single clicking the “Edit Profile” button. The first screen to appear is the General Information screen 
shown below. This allows the user to enter the Client’s and their information. There are several 
optional screens in this profile. The user has the option to enter the data and click “Next” to cycle 
through or this information is optional and can be bypassed by clicking the “Test Setup” Screen. 
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The Stack Information data is optional and is not used in any calculations. It is for descriptive or 
reporting purposes only. 
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The Test Equipment information is also optional. However, the Cartridge or Trap IDs are highly 
recommended to enter. It is optional here because the user is prompted later to enter.  If the console 
has a pitot transducer installed, the pitot coefficient should be entered here. 
By selecting the check box the user may choose to use the front-panel dry gas meter readings as 
backups. If the console is equipped with digital totalizers on the front panel, using the DGM readings 
is not recommended. 
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Alarm Actions 

The Alarm Actions screen is only available in later software versions (071127-69 or later.)  If your 
software version has the Alarm Actions screen, then you may configure the XC6000 to trigger an 
alarm condition based on several available parameters. 

Each alarm condition has several parameters that may be set.  For each sensor input on the Alarm 
Actions screen, a valid range or upper limit may be set, depending on the sensor type.  Additionally, 
most alarms feature an auto-reset function, which serves to return the XC-6000 to a non-alarm state in 
the case of a non-critical alarm condition. 

 DELAY (sec.) Length of time alarm condition must continue before alarm action is 
performed.  For an instant alert, set to zero (0.) 

AUTO-RESET (sec.) Length of time elapsed before alarm condition resets.  When alarm 
condition resets, Alarm Piezo output and dry contact will deactivate. 

ALARM ACTION:   Action performed by XC6000 upon reaching an alarm condition.  See 
table below 

RETURN FROM POWER FAILURE ACTION:   

When the XC6000 returns from a power failure, the unit may trigger 
an alarm.  Any available Alarm Action may be used, including END 
TEST or PAUSE.  If ALERT is used, the alarm may be Auto-Reset 
after a specified interval. 

ALARM DELAY (Startup / Resume) 

When a test run is started or resumed from a pause condition, the 
alarms will be disabled for a minimum of 60 seconds, in order to 
prevent false alarm conditions when establishing the flow baseline.  
This delay may be extended at the user’s discretion.  
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ACTION Description of Action 

ALERT XC6000 Alarm dry contact output will close 

XC6000 Alarm Piezo output will engage 

May be Auto-Reset or reset manually by operator 

PAUSE XC6000 Alarm dry contact output will close 

XC6000 Alarm Piezo output will engage 

Test will pause until manually resumed by operator 

May not be Auto-Reset 

END TEST XC6000 Alarm dry contact output will close 

XC6000 Alarm Piezo output will engage 

Test will end and unit will wait for post-leak test 

May not be Auto-Reset 

DISABLE No action 
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Test Setup 

The Test Setup screen is the meat of the Test Profile. This is where the user selects the test duration, 
averaging period, target flow rates, flow control method, etc.  The External Pause parameters may be 
selected on this screen. 

 
!�"����#$#8%�����������	���������

Test Parameters: 

Duration: Length of time the test is run.  Note that this is the total run time, not calendar or clock 
time.  If a test is paused, the unit will ignore the pause time and will continue the test 
until the entire duration has elapsed.  Entered in Days / Hours / Minutes. 

Averaging Period: Duration of block average points stored in the XC6000 internal memory.  If a 
15-minute averaging period is specified, the unit will average all appropriate data and 
write data points to storage memory every fifteen minutes.  1-minute averaging times 
are recommended for shorter runs.  For longer runs (greater than 24 hours) longer 
averaging times may be used.  

Trap and Probe Heaters Temperature: Setpoint for the console-controlled heaters in the sample 
probe.  This should be set high enough to keep any water vapor or other moisture 
entrained in the stack gas without condensing.  In a “wet” stack (more than 10% 
moisture,) trap and probe heaters should be set to well above stack temperature. 

Chiller Temperature: This parameter does not control the sample conditioner, but it does provide a 
reference temperature used in setting the alarm values.  Typically 35° F. 

External Pause:  Determines whether the unit will enter a pause state when the External Pause input is 
activated.  Disable will never pause, When contacts are shorted and  When 
contacts are open will pause when their conditions are met.  When the unit is paused, 
the sample pumps are turned off and the elapsed time counter is not incremented. 
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External Flow and External Moisture: 

The XC6000 is designed to operate with a proportional flow input, which is used to change the target 
flow rate of the console.  The XC6000 can accept an analog input signal (0-10V or 4-20 mA,) a � P 
signal from a pitot transducer, or a digital flow input over Modbus. 

In order to use proportional flow, select an initial flow rate and an external flow signal source. 

 

In this example, we have selected 500 cc / min. and 4-20mA for our external flow signal.  The 
External Flow Input Scaling fields are designed to make the XC6000 exported data agree with the 
stack flow data obtained by the plant stack flow monitor.  If known, input the correct stack flow value 
observed when the external flow signal is a nominal zero (0V or 4mA.)  Then input a known current / 
voltage and its corresponding stack flow rate.  The Unit field is optional but will be shown in the data.  
If the exact stack flow is not known, the Span mA may be set to the current external signal and the 
Span Flow Rate may be set to the current load percentage.  If this is done, the Unit field should be set 
to “percent load” to indicate this situation in the data. 

The final field is Minutes to establish the baseline, and should be left at 1 minute unless directed 
otherwise. 

When the XC6000 begins sampling, the console will monitor stack flow during the baseline time 
period and will store the average stack flow in memory.  The initial flow rate will be maintained as 
long as the stack flow is equal to the baseline stack flow.  If the stack flow increases, the console 
sampling flow rate will also increase proportionally. 

EXAMPLE: The initial flow rate is set to 500 cc/min.  The external signal is set to 4-20mA, zero = 
0.0001, span 20.00 = 1000 as pictured above.  The unit is set to Kscfm (thousands of standard cubic 
feet per minute.)  When the test begins, the stack flow is 875 Kscfm.  The XC6000 sets its initial flow 
rate of 500 cc/min to be equivalent to 875 Kscfm.  Over the course of the next hour, the load of the 
station increases from 87.5% to 91%.  The stack flow increases from 875 Kscfm to 910 Kscfm (a 4% 
increase,) and the XC6000 increases its sample flow rate from 500 cc/min to 520 cc/min (also a 4% 
increase.)  In this way, the XC6000 maintains proportionality during a sample run. 
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Click “Save” to save this to a location on your hard drive. Please note that selecting “Save” does not 
write any information to the memory of the XC6000.  The XC6000 profile is not updated until all pre-
test preparations are complete.  Click “Main Menu” to start the testing protocol. 
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Pre-Test Leak Check 

Once back at the “Main” screen single click the “Pre-Test Leak Check” button. The following screen 
will appear.  Ensure the sorbent test tubes are inserted in the probe trap receptacles.  Plug the ends of 
the sorbent tubes with clean stoppers. Click the two “Start Test” buttons to individually leak check 
Side A and B. This is a required leak check done at maximum vacuum. The leak check vacuum level 
and flow rate are stored with each test run. The test can be bypassed by checking the “Bypass” button 
and then selecting “Next>>>”. However, this bypass will be logged and stored with the data.  
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Once the test has passed click the “Next” button. The system prompts you to switch the pumps off 
using the “Pump Off” button on the screen. Click next to continue.  The system will automatically 
switch these off prior to starting the test.  
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Set Probe 

The next screen to appear prompts the user to insert the probe when the temperatures are at/near set 
point. If the internal pitot is being used the current/live delta p reading is shown. 
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Test Data Storage Location 

The following prompts the user to select a storage location on the flash memory drive inside the box. 
Single click the number in the left column corresponding to where you want to store the data file. The 
user can select one of up to 99 slots.  Click the “<<Previous” or “Next>>” buttons to scroll through 
the list. The system will prompt to confirm the case of overwriting data. 
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Mechanical DGM Volume Input 

The following prompts the user to enter or confirm the trap ID s and enter the initial dry gas meter 
mechanical readings. This is used as a redundant backup and functionality check of the metering 
system.   
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Test Start 

After clicking “Accept” the following screen appears. The system is ready to start the test.  
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To start, click “Run” and the system should indicate flow with the digital rotameters in the top right of 
the screen. Also, check to ensure the electronic totalizer on the gas meter is incrementing. 
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Stat Screen 

To see a non-graphical representation of the run data screen, single click the “Stat” button and the 
following screen will appear. This screen does override other screens and will need to be closed in 
order to open another screen. Close this screen by clicking the X box in the top right of the screen.  
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Pause Test 

To pause the test, single click the “Pause” button in the center of the screen. The button will then 
toggle to “Run” to continue the test. 
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In addition, a remote pause functionality has been integrated into the software.  By interfacing with the 
remote pause connector on the rear panel of the unit, the user may pause the test without the need for a 
connected PC.  The remote pause functionality is discussed in the Test Setup menu. 

 

Adjust Screen 

The XC6000 is designed to offer flexibility during testing as well as when creating profiles. Press the 
Adjust button to change the trap / probe heater set point or the target flow rate during testing,  
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The Trap Heater Setpoint Adjust section allows either an arbitrary set point or a set point 0-99 
degrees F above the stack temperature to be set.  The original set point is stored and may be recalled 
using this screen as well. 

The Adjust Flow Rate section allows the flow rate to be increased or decreased from the original 
target flow rate.  Positive numbers between 0 and 999 add to the flow rate, while negative numbers 
between -1 and -998 reduce the flow target.  

After changing any parameters on the Adjust Screen, press the Apply New Temperature and / or 
Apply New Flow Rate buttons, and then close the screen by pressing the Close button. 
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End Test  

To end the test there are two options. The user can wait until the system times out and automatically 
stops the test. Second, the user can end the test early by single clicking the “End Test” button in the 
center of the graphical run data screen.  The system will prompt the user to confirm this action. 
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The following prompt informs the user the system will store the data. 
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The following prompt informs the user the Post-Test Leak check is next and to remove the probe from 
the stack and plug the ends of the traps. 
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Post-Test Leak Check 

The following screen displays the status of the leak check and allows the user to start/pause the leak 
check.  The system has logged the highest vacuum achieved for both flow channels A and B as 
displayed in the center box and will control the vacuum level to just over those levels.  Just like with 
the Pre-Test Leak Check, the user can bypass this step but no leak check data will be stored. But if no 
Post-Leak is performed the sample run data will be invalid. 
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After both flow channels have passed. Click the “Next>>>” button and cycle off the pumps and the 
system will inform the user it is storing the leak check data. 
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Export Data 

The system will now go back to the main screen. To export and view the data file(s), Click on the 
Export Data box.  
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Now select test data to export, the bottom right of screen will indicate sample run just completed. 
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Click on the button corresponding to the slot number of the test to be exported.  The XC6000 supports 
99 memory slots, which may be accessed 20 at a time using the Previous and Next buttons. 

 

Export 
Slot 22 

Next Page 
 
Previous 
Page 

Export Data 
Button 
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Export Data Cont. 

Once the slot number button is pressed, the following dialog box will prompt the user to save the file 
to a local or network location. A text file (.txt) and a comma separated value (.csv) file will be 
generated at this user-specified location. The text file can be viewed in various applications such as 
Notepad, Word Pad, Word, Excel, etc. The CSV file is formatted to be opened in a spreadsheet 
application such as Excel. 
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Multi-File Export 

The XC6000 also supports multi-file export, which will export a group of completed test profiles to a 
folder on the local hard drive.  To use multi-file export, select the Multiple Slot Export check boxes 
next to the slots desired.  To select all available slots, press the ALL  button.  To clear all selected slots, 
press the CLR button.   

 

 

Multiple slot 
export check 
boxes 

Export Group 
 
Clear All 
 
Select All 
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Multiple File Export (cont.) 

After the slots are selected, press the Export Group button.  The XC6000 application will prompt the 
user for a directory as in single file export.  With a multiple file export, all slots will be exported to the 
directory selected for the first slot.  Exported files will be named based on their profile name, and all 
will be given unique filenames. 

 

 

 

Set Clock 

The Config/Utilities screen has various other functions built-in. The “Set Clock” button automatically 
synchronizes the MercSampler Console time with the clock time of the computer connected.  

 
!�"����#$0'%������������������+����5�� ������������ ��
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Sorbent Traps 
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M-PCB-DAC-
V3A 

POPULATED Printed Circuit Board for Data 
Acquisition & Control (DAC) Board for XC-
6000EPC Dual PC-Based Hg Console Series 

 

 
   
PCB-TC/MUX POPULATED TC/Mux Board for 

use in XC-6000EPC Mercury 
Console Series. 8 Type K TC 
Channels with External Signal and 
Moisture Analyzer Inputs. 

 
   
PCB-LED-HG BOARD, LED DISPLAY 

 
   
EL-PCB-
MODBUS 

BOARD, TCP/IP MODBUS 
INTERFACE 

 
   
EL-SDCARD A-DATA Speedy 1GB Secure 

Digital (SD) Flash Card Model 
SDC-1G0 
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EL-EBR-2310 D-LINK ROUTER,  IEEE 
802.3/3u, IEEE 802.11b/g Wired-
G Broadband Router 

 
   
EL-WBR-1310 D-LINK ROUTER,  WBR-1310 

Wireless G Router - 54Mbps, 
802.11g, 4-Port, used in Meter 
Consoles in SKB, Environmental 
Enclosures 

 
   
GP-C131-11 PUMP, BTC DIAPHRAGM 

PUMP, BRUSHLESS MOTOR, 
10,000 HR, MAX VACUUM 
20"HG, 12VDC, 3900 RPM, 
MAX PSIG 24", 6 lpm max free 
flow, 900cc @15" Hg 

 
   

DGM-SK25-
5701 

DRY GAS METER, MODEL SK-
25, METRIC,with optical encoder 
(no mechanical index) 

 
   
DGM-SK25EN DRY GAS METER,MODEL SK-

25, METRIC, with optical encoder 
(for XC-6000EPC) 
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TOT4-36X72 QUADRATURE PULSE 
DIGITAL TOTALIZER 

 
   
AK-6000 Deluxe Mercury Audit Kit for 

Appendix K/Method 30B System 
includes:SK25 DGM with 15-pt 
calibration, quadrature 
totalizer,vaccum gauge, 4U black 
polyethylene molded case, 
Handheld type K Thermocouple 
Simulator with Certificate, Hand-
held digital barometer, Digital 
Thermometer, Vacuum Bottle  

   
EL-670-OA938 FAN, AC Fans 92mm 115VAC 

50CFM 

 
   
AWM-4360 Airflow Sensor, Signal 

Conditioning: Amplified; 
Flow/Pressure Range: + 6000 
sccm (6.0 SLPM); Linear Range 
1LPM; Port Style: Manifold 

 
   
XC-6K-PGMC Programming Cable for XC-

6000EPC Automated Mercury 
Sorbent Trap Metering Console. 

 
   
M-AM2312 VALVE, 3-WAY, .055/.048 

ORIFICE, 12V 
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VSO-1SV VALVE, SOLENOID, 
PROPORTIONAL 
Model VSONC-3S11-IC-FO 
MANIFOLD MOUNT WITH 
WIRE LEADS AND 11.5VDC 

 
   
SP-PSE541-M5 SENSOR, PRESSURE, 0-30" Hg, 

1 NPN/PNP OPEN COLLECTOR 
TRANSISTOR OUTPUT, 
30VDC, 125mA 

 
   
BARO-A-4V Barometric Pressure sensor, 600 to 

1100 mbar,  temperature 
compensated, amplified output 

 
   
M-CBR10A-M Magnetic Type Circuit Breaker 

Rocker Switch, 10 Amp. 
Horizontal Mount. Typically Used 
in 120V Consoles as Probe/Oven 
Breaker Switch. 

 
   
M-CB15A-M Magnetic Type Circuit Breaker, 15 

Amp., Typically Used in 120V 
Consoles as Main Breaker. 

 
   
D-60A POWER SUPPLY, 5V@6A, 

12V@ 4A, Meanwell 
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EL-P1082-031 CONNECTOR, A TO B USB, 
PANEL MOUNT 

 
   

EL-TL5242W Memory Backup Lithium Batteries 
3.6V 2.1Ah BATT PACK 

 
   
PCB-BATTERY Battery interface board with short-

term capacitor backup 

 
   
TC-PJK THERMOCOUPLE JACK, TYPE 

K, PANEL, SNAP-IN 

 
   
AM-T3107000 AMP. CONN, 7P FEMALE, PNL, 

C16 
C16-1 Series Amphenol Circular 
Connector. High Grade Plastic for 
Harsh Environmental Conditions. 
Panel-Mount Straight Female 
Slots, 7 Slot (6 + Ground (First 
Mate/Last Break)) – Hardigg Case 
external input connector 

 

   
AM-T3108          AMP. CONN, 4 PIN 

(MALE),CBL,C16 – Probe / Trap 
Heater power connection, console 
side 
 

 

   
AM-T3109          AMP. CONN, 4 SCKT 

(FEMALE),CBL – Probe / Trap 
Heater power connection, probe 
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XC-6K-MANI MANIFOLD SUBASSY, XC-

6000EPC  
Includes vac sensor, mass-flow 
sensor, manifold valve, 
proportional valve, ss hose barb 
fittings.  Assembly calibration data 
to be provided with 
this unit. 
 

 

�

����
SSR-330-25 RELAY, SSRT, 25A 110/240V 

 
   
SGC-TR4/7-SCR HEAT EXCHANGE ASSEMBLY 

FOR STIRLING GAS 
CONDITIONER 
Heat Exchange Assembly, 4 inch 
inner Tube, 7 inch overall with 
outer tube. 

 
   
26840 CARTRIDGE, Aluma-Sorb Gas 

Drying Unit with 1/8" SS FNPT 
Fittings. 2-5/8"x11-3/8".  50g H2O 
Capacity. <.01psi@200lph press 
drop. 90psig working press. 
Polycarbonate 

 
   

26809 MOUNTING CLIP FOR 
ALUMA-SORB CARTRIDGE 
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AM-SP100A Fan, for Stirling Chiller, 115V, 
Sunon 95/115 Air Flow 

 
   
M-SD31 Temperature Controller, Red LED, 

Watlow 

 
   
M-PSRS7512 POWER SUPPLY, 75W, 12V, 6 

AMP, INPUT: 100-240VAC 

 
   
D-60A POWER SUPPLY, 5V@6A, 

12V@ 4A, Meanwell 

 
   
M-PCB-REG-A REGULATOR PCB ASSEMBLY, 

5V, for use with M-PSRS7512 

 
   
M-CBR10A-M Magnetic Type Circuit Breaker 

Rocker Switch, 10 Amp. 
Horizontal Mount. Typically Used 
in Cooler as AUX breaker 
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M-CB15A-M Magnetic Type Circuit Breaker, 15 
Amp., Typically Used in Cooler as 
Main breaker 

 

��
:��
TC-SP-K Thermocouple Plug, Mini, Type 

K, Male 

 
   
TC-LJ-KA TC, CONNECTOR ASSY, 

TYP.K, F, CORD 7.200 7.20 
Includes: Female Type K 
Thermocouple Plug Assembly, 
Cord-mount, with cover, screws 
and bushing. 
 

 

   
TC-LPS-KA TC, CONNECTOR ASSY, 

TYP.K, M, CORD 5.500 5.50 
Includes: Male Type K 
Thermocouple Plug Assembly, 
Cord-mount, with cover, screws 
and bushing. 

 

   
TC-MJ-KA TC CONN. ASSY. MINI, TYP K, 

CORD, F 5.500 5.50 
Mini-Thermocouple Assembly, 
Type K, Female, Cord Mount, 
includes Plug, Cover, Screws and 
Bushing 
 

 

   
TC-SP-KA TC CONN. ASSY. MINI, TYP K, 

CORD, M 5.500 5.50 
Mini-Thermocouple Assembly, 
Type K, Male, Cord Mount, 
includes Plug, Cover, Screws and 
Bushing 
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WK-125CI Replacement Thermocouple with 
Magnesium Oxide Insulation, 
Type K, 1/8" Dia, per ft 

 
   
MPT-6-133H Modular Pitot Tip, 'S' type  
   
HGH-4T463W Replacement Probe Heater, 4-ft, 

463 watt 

 
   
HGH-5T1650W Replacement Probe Heater, 5-ft, 

1650 watt 

 
   
HGH-STRI72 Replacement Probe Heater, 6-ft, 

2000 watt 

 
   
HGH-2T144W Replacement Probe Heater, 2-ft, 

575 watt. (used on all probes, exit 
end of probe) 

 
   
HGH-9T838W Replacement Probe Heater, 9-ft, 

838W 
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HGH-12T1000W Replacement Probe Heater, 12-ft, 
1000W 

 
   
HGP-STA Small Trap (6mm) Adapter for 

Mercury Probes. Includes 
10MTUR6M-S (with 10mm Nut 
and ferrule) and Three 1/4" 
Ceramic Ferrules 

 
   

�
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DIF-N70 FILTER , INLINE, 
DISPOSABLE, NYLON 
Disposable In-Line Filter, Nylon 
Housing with 1/4" tube stubs, 
95%+ efficiency for 0.1 micron.                                                                          

 

�
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GSB-1000SC SAMPLE BOTTLE, CLEAR 
GLASS,GL-45 THREADED, 
1000mL Safety Coated, for 
Condensate Collection 

 
   

GSB-400SC SAMPLE BOTTLE, CLEAR 
GLASS,GL-45 THREADED, 
500mL Safety Coated, for 
Condensate Collection, used in 
16U shock mount rack chiller 
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GSB-250SC BOTTLE, SAMPLE, CLEAR 
GLASS, GL-45 THREAD, 250mL 
with Safety Coat Sample Bottle, 
250mL, used in SC-40 condensate 
collection ice bath 

 
   

GA-GL-45S Seal for 1000 ml bottle 

 
   

GA-GL-45B Cap for sample bottles – fits 
1000mL, 500mL, 250mL bottles 

 

   

ALUMA-SORB ACTIVATED ALUMINA 
DESSICANT, highly efficient 
adsorbent with high porosity and 
contact surface. 1/8" diameter 
beads, 2.5Kg  (5.5 LB) container 
with 80% active alumina (>/= 
92%) and 20% silica gel.  

   

AG-1080 DESSICANT AIR DRYER WITH 
INDICATOR, disposable drying 
canister 

 

   

QC-PMC2 QC, STIRLING GAS 
CONDITIONER, MALE, 
STRAIGHT CONNECTOR, ¼” 
OD PTF, 1/8"ODX.170"ID (used 
on Drierite Cartridge outlet/top) – 
Threaded Male 

 
   

QC-SGC-F4 QC, STIRLING GAS 
CONDITIONER, FEMALE, 
FERRULLESS POLYTUBE 
FITTING, PTF (used on jumper 
from Stirling Cooler to sampling 
console) – Tube-Mount Female 
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QC-SGC-F3 QC, STIRLING GAS 
CONDITIONER, COUPLING 
BODY, 1/4"OD, FEMALE, 1.73"  
(on Stirling, sample-in connection) 
– Threaded Female 

 
   

QC-SGC-M2 QC, STIRLING GAS 
CONDITIONER, STRAIGHT 
CONNECTOR, FERRULESS 
POLYTUBE FITTING, PTF, 
1/4"ODX.170"ID (Heated U-Cord 
Sample Line to Stirling, high-SO2 
connector) – Tube-Mount Male 
 

 

   

HGU-10DJ TUBING, PFA, 5/32ID X 1/4OD 
X .047 WALL (jumper from 
Stirling Cooler to sampling 
console), replace 10DJ with 
desired length (standard is 10ft.) 

 

��
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9531K22 CAP, VINYL PROTECTIVE, 
used for capping sorbent traps 
during pre- and post-leak testing 

 

   

10MMNU-S-
EXT 

PARTICULATE SHIELD FOR 
10MM SORBENT TRAP 
Stainless Steel Tube, 3/4" o.d. x 
1.25" L with 10mm nut, welded 

 
   

10MMNU-C-
EXT 

PARTICULATE SHIELD FOR 
10MM SORBENT TRAP,C276 
Hastelloy C276 Tube, 3/4" o.d. x 
1.25" L with 10mm nut, welded 
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10MMNU-S NUT, 10MM TUBE, Stainless 
Steel 

 
   

10MMBLP-S PLUG, 10mm TU, SS – thread-on 
plug for end of probe, protects 
probe when not sampling 

 

   

SR-2.625 Neoprene square ring, 2" ID x 2 
5/8" OD x 3/16" tk, for cam-lock 
connectors 

 
   

10M-F-TG FERRULE, 10MM, Single, Glass 
filled Teflon 

 
   

4NU-S NUT, 1/4 TUBE, Stainless Steel 

 
 
 


